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Le texturing

§ Prérequis.

	 § Avoir lu Blender initiation «Interface», «Modélisation», «Lumière».
	 § Avoir un objet sélectionné.
	 § Avoir créé une  nouvelle fenêtre et y avoir ouvert le «Shader Editor».

	 § Avoir Cliqué sur «New».

Shader Editor.

New.

Le texturing en 3D fait référence au processus de création et d’application de textures sur des objets en trois 
dimensions.
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	� §  �Avoir deux «Nodes» qui apparaissent dans le «Shader Editor» 
	 Avoir le nom de votre matériau qui s’affiche.

	� § Avoir basculé en «Rendered» en cliquant sur la dernière boule  du «Viewport Shading». 

Node
Node

Rendered

Viewport Shading

Nom du Matériaux.
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§ Erreurs Possibles.
	� § Vous ne voyez pas «New» dans le Shader Editor et vous voyez vos deux nodes: 
		�  C’est que vous avez déjà un matériau, vous pouvez maintenant basculer en «Rendered» en 

cliquant sur la dernière boule  du «Viewport Shading».

	� § Vous ne voyez pas «New» dans le Shader Editor et vous voyez le nom de votre ma-
tériau, mais vous ne voyez pas les deux nodes:

		  C’est que les deux nodes sont cachés. Pour les afficher :
			   >Positionner la souris dans le Shader Editor 
			   >Cliquez sur «a» de votre clavier pour les sélectionner.
			   >Cliquez sur le point du Pavé numérique. 
		�  Vous pouvez maintenant basculer en «Rendered» en cliquant sur la dernière boule  du 

«Viewport Shading».

Nom du Matériau

Node Node

Nom du Matériau.

Le Point du pavé
Numérique.

pas de Nodes
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§ Principes.

La fenêtre d’édition shader Editor permet de régler les matériaux et les textures en utilisant des nodes. 

	 § Les Nodes
	� Les nodes (nœuds en français) représentent symboliquement des fonctions ou l’ensemble de  pixels 

composant une image.
	 Les nodes sont connectés entre eux par des connecteurs Vert, gris, Jaune, bleu, 
	� L’ensemble des nodes connectés entre eux s’appelle un système de nœud et fonctionne de gauche à 

droite.
	 Les nodes s’ajoutent avec le menu Add du Shader Editor.

Exemple de Node

Connecteur Vert : 
Ce sont les prises pour les shader. Les shaders sont des pro-
grammes qui gèrent les paramètres de l'aspect d'une surface 
ou d'un volume. Transparence, miroir, texture, etc...
Un matériau sera défini par l'ensemble des shaders contenus 
dans le système de nœud.

Connecteurs Gris :
Connections de données numériques ou graphiques 1 seule 
valeur est distribuée du noir au blanc pour chaque pixel d'une 
image (niveaux de gris). On peut parler d'une carte de coor-
données de positionnement de chaque pixel sur une image 
(carte de valeurs ou value map en anglais. Utile pour les 
masques, une information de transparence qui s'étale sur un 
niveau de gris.

Connecteurs Jaune :
Connections de couleurs de l'image, 4 valeurs sont ainsi traitées (RGBA) pour chaque pixel d'une image.

Connecteurs Bleu : 
Connections de données vectorielles ou géométriques qui se rapportent à la 3D et qui s’écrivent 
sous la forme de trois nombres xyz. C'est un moyen pour décrire une dimension, une profondeur, 
une distance, un angle, une vitesse.

		  § Les connecteurs.
			�   Il y a des connecteurs d’entrée et des connecteurs de sortie. Ils permettent de relier les 

nodes entre eux pour faire circuler différents types de données.

			   Les couleurs de connecteurs correspondent à des types de données. 
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		  § Les liaisons entre les nodes:
			�   Pour relier deux nodes il faut positionner la souris sur le connecteur de départ puis 

garder enfoncé le clic gauche et tirer jusqu’au connecteur d’arrivée et relâcher le clic 
gauche.

		  § Raccourcis pour la manipulation des nodes:
			   Couper une liaison : CTRL enfoncé Clic Droit glisser souris.
			   Supprimer un node sans rupture de liaison : CTRL enfoncé X.
			�   Déplacer un node sans casser les liaisons : ALT enfoncé tout en attrapant le node à 

déplacer.
			�   Les entrées inutilisées peuvent être masquées avec CTRL H et CTRL H pour le faire 

apparaître.
			   Désactiver un node: M (mute).

	 § Description et fonctionnalité des nodes de base:
		  § Le Node «Material Output».

Ce node représente toutes les faces de votre objet.

		  § Le Node «Principled BSDF». 

Ce node est un shader.
Les «Shader» vont permettre d’appliquer des couleurs «uniformes» 
sur des objets. Les objets vont ainsi absorber et renvoyer la lumière 
à des niveaux et à des qualités différentes avec ombrages différen-
ciés. On peut ainsi déterminer si la surface d’un matériau est mate, 
brillante, translucide ou transparente.
Si je parle de couleur uniforme, c’est que lorsque le shader traite 
une couleur, la couleur sur chaque pixel devient différente à cause 
des différentes intensités lumineuses et des ombrages. 

		�  Le node «principled BSDF»est un node qui regroupe l’ensemble des shader, il peut donc faire 
du mat, du brillant, du transparent etc...

		�  Il est possible d’avoir dans Blender des shader qui ne font qu’une seule chose, soit du brillant, 
soit du glossy, soit du transparent, etc... 

Pour mélanger deux 
Shader.

Pour avoir des
transparences.Pour avoir du Brillant.Pour avoir du Mat.
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	 § Mes premiers matériaux:
		  § Je veux mettre une couleur sur un objet :
			   § Je veux que cette couleur soit rouge avec un léger reflet(spéculaire)
				�    J’utilise le shader Diffuse et je choisis une couleur  dans l’onglet prévu à cet 

effet.

Menu Add.

		  Les Shaders se trouvent dans le menu Add du Shader Editor dans le liste Shader.

Couleur «uniforme». Traitement de la couleur
par le shader. les ombrages 
apparaissent.

C’est ici que je règle la quantité 
de reflet(spéculaire) IOR (indice 
de spéculaire).

C’est ici «Roughness» que je 
règle la diffusion du reflet.

Représente les faces
de l’objet.

Léger reflet.
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			   �§  Je veux que mon reflet(spéculaire) soit moins diffus. Je règle le 
«Roughness».

Couleur «uniforme».

Couleur «uniforme».

Traitement de la couleur
par le shader. les ombrages 
apparaissent.

Traitement de la couleur
par le shader. les ombrages 
apparaissent.

C’est ici que je baisse le re-
flet(spéculaire).

C’est ici que je baisse le re-
flet(spéculaire).

C’est ici «Roughness» que je règle la 
diffusion du reflet.

C’est ici «Roughness» que je règle la 
diffusion du reflet.

Représente Les faces
de l’objet.

Représente Les faces
de l’objet.

Reflet (spéculaire)
plus marqué.

Moins de reflet.

			�   § Je veux une couleur mate. Il faut que je diminue le reflet (spéculaire). 	
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		�  §  Je veux mettre une image sur un objet:
		  Pour mettre une image sur un objet:
			   § Il me faut trois nouveaux Nodes.	 		

			   Le Node «Image texture».

			   Le Node «Mapping».

			   Le Node «texture Coordinate».

Ce node représente une image 
que l’on va ouvrir avec Open. 

Ce node représente les coordonnées 
(Locale) de mon image plaquée sur mon 
objet.

Ce node représente quels types de coor-
données je vais utiliser pour plaquer mon 
image sur mon objet.
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Node Texture Coordinate : 
Quelles coordonnées utiliser
pour plaquer la texture 
sur l’objet.

Node Mapping.
Gère les coordonnées (coordonnées lo-
cales) de l’image plaquée sur l’objet.

Node Diffuse.
Le shader transforme les couleurs uniformes des 
couleurs de l’image en matériaux (verre, mat, 
brillant, etc...).

Node Image texture:
C’est ici que l’on charge l’image.

Représente Les faces
de l’objet.

			�   §  Il me faut les connecter entre eux pour créer le Système de nœuds de 
base pour plaquer une Image texture sur un objet.

			   �§ Il me faut connaitre les coordonnées de mon image:
			   Une image est un plan elle a une résolution x, y.

Y

x
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		�	�   § Il me faut déterminer quel système de coordonnées je vais utiliser 
pour plaquer ma texture image sur un objet 3D.?

				  
			�   C’est le node «Texture coordinate» qui va décider de ces coordonnées.

«Generated» La texture va se projeter complètement sur l’objet. Ces coordonnées 
sont délimitées par la boite englobante du maillage et leur origine se trouve dans le 
coin inférieur gauche de cette boite englobante.

«Normal»C’est le vecteur normal des faces qui est utilisé pour les coordonnées. Utilisé 
pour les effets dépendants de l’angle de vision.

 «UV» Distribuera la texture selon les coordonnées UV du dépliage de l’objet(uv map-
ping).

«Object» Distribuera la texture dans l’espace individuel de l’objet. Ici l’origine des coor-
données sera l’origine de l’objet.

«Camera» Projette la texture sur l’objet à partir de la caméra. Les coordonnées ont 
pour origine, l’origine de la caméra.

«Window» Projette la texture sur l’objet à partir de la fenêtre de la 3D view.

 «Reflection» Permet de faire une fausse réflexion sur un objet précis..

		  Visualisation des coordonnées de texture:
�		�  Je peux visualiser les coordonnées du nodes «Texture Coordinate»car Blender peut transfor-

mer en couleur les valeurs des coordonnées qu’il utilise. 

Cette couleur rouge représente les coordonnées :
(1 en X, 0 en Y, 0 en Z) 
soit le vecteur (1,0,0).

Cette couleur verte représente les coordonnées :
(0 en X, 1 en Y, 0 en Z) 
soit le vecteur (0,1,0).

Cette couleur bleu 
représente 
les coordonnées :
(0 en X, 0 en Y, 1 en Z) 
soit le vecteur (0,0,1).
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Cette couleur magenta
représente 
les coordonnées :
(1 en X, 0 en Y, 1 en Z) 
soit le vecteur (1,0,1)

Cette couleur jaune 
représente 
les coordonnées :
(1 en X, 1 en Y, 0 en Z) 
soit le vecteur (1,1,0)

Cette couleur noire 
représente 
les coordonnées :
(0 en X, 0 en Y, 0 en Z) 
soit le vecteur (0,0,0)
Il s’agit donc de l’Origine

0,0,0 1,0,0

1,0,1
0,1,1

1,1,1

0,0,1

1,1,0

Visualisation des vecteurs «generated».
Origine de la boite englobante.

		�  Pour visualiser ce que fait un node sur les faces de votre objet, vous pouvez ainsi directement 
relier n’importe quel Node au node «Material Output». Vous verrez alors ses coordonnées en 
couleur sur l’objet.
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 			�   La boite englobante «Bound»est une boite qui englobe chaque objet. On peut la vi-
sualiser dans la fenêtre des properties>Panel Viewport Display>Menu déroulant du 
«Display as».

 			�   L’image commence à se plaquer sur le coin inférieur de la boite englobante et se copie 
le long de l’axe z, elle est projetée (projection) à plat (flat). C’est pour cela qu’elle semble 
«couler» sur l’axe des Z.

La projection sur le node Image Texture
 est sur Flat.

L’image semble «couler» car La projection 
sur le node Image Texture est sur Flat.

J’ai choisi de plaquer une seule fois 
l’image en choisissant Clip.

			�   §  «Generated» La texture va se projeter complètement sur l’objet. Ses coordonnées 
sont délimitées par la boite englobante du maillage et leur origine se trouve dans le 
coin inférieur gauche de cette boite englobante.

			 
			�   NOTA: Vous verrez plus tard en notions Blender avancées, qu’en fait il s’agit du Texture 

Space calé sur la boite englobante.

Contexte Object de la fenêtre d’édition des «Properties»
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 			�   Changeons la projection sur «Box», l’image se projette sur les trois axes.

La projection sur le node Image Texture est sur 
maintenant sur Box.

			�   Utilisation du node Texture image pour plaquer une texture sur un objet.

Plaque la texture sur XY.

Plaque la texture sur XY, XZ, YZ.

L’image se répétera.

L’image s’étalera sur la face.

L’image ne se répétera pas.

Plaque la texture sur une sphère.

Plaque la texture sur un tube.

Projection de l’image.

Extension de l’image.
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			   § �«UV» Distribue la texture selon les coordonnées UV du dépliage de l’objet (uv map-
ping) (uv mapping).

					�    

				  
				  
				    �§ Il s’agit ici de déplier l’objet à plat comme lorsqu’on fait le patron d’un vête-

ment. 

			   �	 §Prérequis pour les UV
					     Ouvrir une nouvelle fenêtre : L’UV Editor.
					     Ouvrir une nouvelle fenêtre de travail.
					     Faire un dépliage UV.

Fenêtre pour visualiser
le rendu.

La boule «Material Preview»
est  sélectionnée

La boule «Solid»
est  sélectionnée.

UV Editor. Faire un dé-
pliage UV.

Fenêtre de Travail.

NOTA: Dans l’exemple ci-dessus vous cliquez sur la boule Matérial Preview pour voir le rendu en temps réel, 
c’est un peu équivalent de la Boule «Rendered»à ceci près que «matérial preview» a un éclairage d’ambiance 
installé dans le «World».  
Cf  le mémo sur la Lumière.
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				    § Faire un dépliage UV:
					�     Lorsque vous ajoutez une primitive, elle est déjà dépliée. La carte UV 

se trouve dans la fenêtre des properties> Context data de l’objet>Panel 
UvMap. 

					�     Supprimer la carte UV en cliquant sur le «-»  du tableau.
					     § Nous allons déplier deux faces de votre objet.
						      >Sélectionner deux des faces du cube.

						      >Cliquer sur le menu UV et choisir «Unwrap».

Dépliage Uv de la primitive 
Cube par défaut.

Emplacement de la carte 
Carte Uv.

Sélection des deux
Faces du cube.

Choisir Unwrap.
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1,1,0

						      >Les deux faces apparaissent dépliées sur l’UV Editor.

						      >Cliquer sur le menu UV et choisir «Unwrap».

					     § Déplier trois faces de votre objet:
						      >Sélectionner trois des faces du cube.

Choisir Unwrap

Les deux faces apparaissent dépliées. Si 
vous les déplacez, l’image appliquée sur 
le cube de l’image de gauche se déplace 
également.

L’image apparait sur les deux 
faces du cubes dépliées.

Sélection des trois
Faces du cube.

Les faces ne se déplient pas correcte-
ment. Il faut faire une couture (Seam).
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						      >Mettre une couture(seam) sur une Edge de l’objet
							�       Sélectionner une Edge de l’objet en allant dans le menu 

de la 3Dviewport >Edge>Mark Seam.

						�      Autre exemple de dépliage d’une sphère avec «Mark Seam» à 
l’équateur.

Je sélectionne une Edge. Je sélectionne les trois faces et je 
refais Unwrap.

Je marque la couture
Edge>Mark Seam.

1 - Je marque la couture
Edge>Mark Seam.

3 - Je Fais Unwrap 2 - Toutes les faces sont 
sélectionnées avant de 
faire unwrap.

Le dépliage est correct.
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			�   «Object» Distribue la texture dans l’espace individuel de l’objet. Ici l’origine des coor-
données sera l’origine de l’objet.

			�   Avec Ce système de coordonnées les textures procédurales seront mieux distribuées.

La texture à pour origine l’origine 
de l’objet.

Texture Coordinate 
sur «Object».

Texture Coordinate 
sur «Generated».
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	 �§  Je veux mettre une texture procédurale sur mon objet:	
	� Les textures procédurales sont générées mathématiquement et elle produisent ainsi des masques 

noirs, blancs et niveau de gris. Il peuvent se déployer sur de grandes surfaces sans pixeliser.
		
		  Pour mettre une texture procédurale sur mon objet:
		  § Il me faut différents nodes.

			   Les nodes de Textures procédurales.
			   Il en existe plusieurs. Ces nodes vont générer un masque en niveau de gris.

Le Node «color ramp»

Le Node «Mix»

Le nœud Color Ramp est utilisé pour faire 
correspondre des valeurs à des couleurs à 
l’aide d’un gradient. 
Il permet aussi de ramener des valeurs de 
gris à des valeurs de noires et de blancs.

Le Node Mix mélange les images en travaillant 
sur les pixels individuels et correspondants des 
deux images d’entrée. 

Utilisé pour réaliser 
des effets de mar-
telages du cuivre 
(Dinanderie) ou 
pour des écailles.

Pour ajouter des 
lignes et des vagues. 
Idéale pour les vei-
nages de bois.

Intéressant pour tout 
ce qui est organique.

Pour faire du grain 
ou ajouter une 
texture de taches 
multicolores.

 Idéal pour un mur 
ou un Plancher.
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Variation Noise Texture

Variation Musgrave Texture

Variation Voronoi Texture
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Node Texture Coordinate : 
Choisir «Object».

Node Mapping
Gère les coordonnées (coordon-
nées locales) de l’image plaquée 
sur l’objet.

Node Shader.

Node Mix Color
Nous avons ici choisi 
de mixer une couleur 
verte et une couleur 
bleue.

Node Texture Voroni.

Le masque Noir et blanc et 
niveau de gris.

Réglage des formes de Noires, 
de Blancs de niveau de gris.

Node Image texture:
C’est ici que l’on charge l’image.

Représente Les faces
de l’objet.

		  �§  Il me faut les connecter entre eux pour créer le Système de nœuds de base 
pour plaquer une texture procédurale sur un objet.

			�   Principe.
				�    Pour régler une texture procédurale connectez-la directement au node «maté-

rial output».



Page 22

				    �Un masque est constitué de valeurs allant de 0 à 1.
				    Le 0 correspond au noir.
				    Le 1 Correspond au Blanc.
				    Entre ces deux valeurs nous avons des niveaux de gris.

				    �Si je zoome sur mon masque jusqu’au pixel. Il y a des pixels complément noirs, 
des pixels complément blancs et des pixels de différentes valeurs de gris. Ces 
pixels ont des valeurs de 0 pour le noir de 1 pour le blanc et une valeur com-
prise entre 0 et 1 pour les niveaux de gris..

Avec le Node «Mix Color» Je peux mélanger deux couleurs, 
mon facteur de mélange  est ici de 0.500.

Le masque Noir et blanc et 
niveau de gris.

Valeur de ce  Pixel 0

Valeur de ce  Pixel 0.520
Valeur de ce Pixel 1
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Mon facteur de mélange  est ici de 0.500.

Tous les pixels ont un facteur de 0.500.

				�    C’est comme ci je connectais un masque dont tous les pixels auraient la même 
valeur ici  0.500.
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				�    Si maintenant on intercale un node «Mix Color» et qu’on connecte la texture 
procédurale au «fac». Le vert va remplacer le noir, le bleu le blanc et les valeurs 
intermédiaires mixées dans les niveaux de gris.

				�    Suppression des niveaux de gris de la texture avec le color Ramp.
					     >Je commence par régler ma texture en direct (noir et blanc).
					     >Je fais varier les valeurs de gris vers le Noir et le Blanc.

				�    Suppression des niveaux de gris de la texture avec le color Ramp.
					�     >Je réintroduis le «Mix Color» et le shader dans mon système de 

nœuds.

Je supprime les niveaux de 
gris. 
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				�    Ajout d’un node «Bump» dans mon système de nœud. 

				    Ce node permet de donner l’illusion de volume sans ajouter de faces.

	� §  Je veux mettre un shader transparent sur mon objet: 
		�  Pour Cycles (Cf: Initiation Rendu) la transparence apparaîtra automatiquement, Pour le Mo-

teur de rendu EEvee, il faudra faire quelques réglages supplémentaires.		
		  § Il me faut un nouveau Nodes pour Cycles et EEVEE.			 

Le Shader Transparent.

		  §Il me faut régler pour EEVEE.
			�   Dans le Contexte «Material» de la Fenêtre d’édition des «properties» et dans le panel 

«Settings» activer le menu déroulant «Blend Mode». et choisir «Alpha Blend»

Blend Mode

Choisir Alpha Blend


